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บันทึกจาก
ผูอํานวยการสํานักคอมพ

ในชวงเปดเทอมใหมปการศึกษา 25
มิถุนายนนี้ สํานักคอมพิวเตอรไดทําการเ
ใหบริการชาว มศว ออกมาใหม 2 โปรแก
Course Publisher และ โปรแกรม SWU W
โปรแกรม Course Publisher Version

อาจารยในการสราง Course Syllabus 
ผานเว็บไซทของมหาวิทยาลัยอยางอัตโนม
การนํา Course Syllabus ขึ้นเผยแพ
รายการ สําหรับโปรแกรม Course Publ
เพียง Version 1.0 ยังมีหนทางในการพัฒ
ชวยงานสอนของอาจารยไดอีก ซึ่งในจดห
นําเรื่องของ Course Publisher มานําเสน
ในสวนโปรแกรม SWU Web Mail เปน

มาแทนระบบอีเมลตัวเกาบนเครื่อง psm
pairin สําหรับนิสิต ที่ไดใหบริการมาตั้ง
สามารถอานรายละเอียดเรื่องนี้ไดในจดหม
กัน 
อีกส่ิงหนึ่งที่ผมเฝาติดตามมานานคือกา

ควบคุมและการจัดการเครื่องคอมพิวเตอร
กลาง ไมต่ํากวาหนึ่งปที่เราพยายามศึกษา
รายงานสรุปผลการศึกษาและการทดสอบ
หมายใหทําการศึกษา สรุปไดวาระบบม
ทํางานไดตามความตองการที่ไดวางไว ท
มีประสบการณและความรูเพียงพอที่จะติด
โดยจะเริ่มติดตั้งและทดสอบใชงานจริงในข
คอมพิวเตอรที่สํานักคอมพิวเตอรเปดใหบร
บุคลากรทุกคนที่ชั้น 3 เราตั้งใจดําเนินก
การปรับพื้นที่ใหบริการ ที่ไดงบประ
มหาวิทยาลัยมา สําหรับเหตุผลที่ใชเว
เรื่องนี้จะไดนําเสนอในจดหมายขาวครั้งหน
สุดทาย ยังมีบริการใหมที่จะเปดตัวในเ

บริการพื้นที่เว็บสวนบุคคล ซึ่งในจดหมาย
ไดมีโอกาสมานําเสนอใหทานรับทราบในร
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SWU Webmail 
 อาจารยสาโรช  เมาลานนท  swu.ac.th 
 

1. 

2. 

ในปการศึกษา 2545 นี้ สํานักคอมพิวเตอรไดติดตั้งระบบ
อีเมลใหม ชื่อวา SWU Web Mail ซึ่งเปนระบบอีเมลแบบ
ใหมที่ผูใชบริการสามารถเรียกใชงานรับสงอีเมลโดยผานเว็บ 
เพื่อทดแทนระบบอีเมลเดิม 
องคประกอบของระบบอีเมล 
ระบบอีเมลมาตรฐานที่ใชในอินเทอรเน็ต มีองคประกอบ

หลักอยู 2 สวน คือ 
สวนเซิรฟเวอร ทางเทคนิคเรียกวา MTA (Mail Transfer 
Agent) เปนโปรแกรมที่ทําหนาที่คลายกับที่ทําการ
ไปรษณีย คือบริการรับและสงจดหมายใหกับผูใชที่อยู
ในอาณาเขตของที่ทําการไปรษณียนี้ กับที่ทําการ
ไปรษณียอื่น โปรแกรมนี้เรียกวา เมลเซิรฟเวอร ผูใชไม
จําเปนตองไปศึกษาอะไรใหมากมาย เปนหนาที่ของผูดู
แลระบบอีเมลของหนวยงานที่จะตองดูแล ส่ิงที่ผูใชควร
ทราบก็เพียงแตชื่อของเมลเซิรฟเวอรที่เราเปนสมาชิกอยู  
สวนไคลเอนต ทางเทคนิคเรียกวา UA (User Agent) 
เปนโปรแกรมที่ผูใช ใชในการอานหรือเขียนจดหมาย 
เชน โปรแกรม Pine, โปรแกรม Outlook Express, 
โปรแกรม Netscape Mail หรือโปรแกรมในลักษณะการ
เรียกใชผานเว็บที่มหาวิทยาลัยกําลังติดตั้งใหมอยู สวน
นี้เปนสวนที่ผูใชตองสนใจ และฝกใชงานใหคลอง 

องคประกอบหลักนี้ใชโปรโตรคอลที่เกี่ยวของมีอยู 3 โปรโตร
คอล คือ SMTP (Simple Mail Transport Protocol), POP 
(Post Office Protocol) และ IMAP (Internet Message 
Access Protocol) เปนมาตรฐานในการทํางานติดตอถึงกัน
และกัน  

โปรแกรมสวนของผูใช 
โปรแกรมสวนของผูใชงานระบบอีเมล เพื่อทําการอานและ

เขียนอีเมลนั้น มีวิวัฒนาการเรียงตามลําดับเวลาจากอดีตถึง
ปจจุบัน 3 ชวง คือ ชวงแรกเปนโปรแกรมที่ติดตั้งบนเครื่อง
เซิรฟเวอรในทางเทคนิค เรียกวา Host-base mail ชวงสอง
ยายมาติดตั้งบนเครื่องพีซี เรียกวาเปนลักษณะ Off-line mail 
และสุดทายเปนที่นิยมในปจจุบันเปนลักษณะการเรียกใช
ผานเว็บ เรียกวา Web-base mail 

โปรแกรม Host-base mail: โปรแกรม Pine 
โปรแกรมนี้ใชงานบนระบบปฏิบัติการ Unix  และเปน

โปรแกรมที่รันบนเครื่องที่ทําหนาที่เปนเมลเซิรฟเวอร (MTA) 
ดังนั้นผูใชงานโปรแกรม Pine จึงจําเปนตองใชบริการ 
โปรแกรม Telnet บนเครื่องพีซีตอเขาเครื่องเมลเซิรฟเวอร (ใน
กรณีของ มศว คือเครื่อง psm.swu.ac.th สําหรับบุคลากร 
pairin.swu.ac.th สําหรับนิสิต) เมื่อผานการพิสูจนสิทธิดวย
การใส Login และ Password แลว จึงจะสามารถเรียกใช
โปรแกรม Pine ได การที่ผูใชงานสามารถเขาไปในเครื่องที่ทํา
หนาที่เปนเซิรฟเวอร และการที่ตองเปดบริการโปรแกรม 
Telnet บนเครื่องเซิรฟเวอร กอใหเกิดจุดออนกับระบบความ
ปลอดภัยบนเครื่องเซิรฟเวอรอยางมาก ในชวงหลังหลาย ๆ ที่
จึงพยายามปดบริการการใชโปรแกรม Pine ลง 
โปรแกรม Off-line mail 
เปนโปรแกรมในสวนของผูใช ที่ใชในการอานและเขียน

อีเมล เชนเดียวกับโปรแกรม Pine แตตางกันที่วา โปรแกรม
ลักษณะนี้ จะติดตั้งอยูบนเครื่องพีซีตางหาก แยกออกมาจาก
เครื่องเมลเซิรฟเวอร โปรแกรมจะติดตอกับเมลเซิรฟเวอร
เฉพาะเมื่อตองการไปดึงจดหมายที่เขามาใหมที่รออยูบน
เซิรฟเวอรมายังเครื่องพีซี หรือเมื่อเขียนจดหมายเสร็จแลวสง
ไปใหเมลเซิรฟเวอรเพื่อจัดสงใหเทานั้น ตัวอยางโปรแกรม
ลักษณะนี้ ไดแก โปรแกรม Outlook Express, โปรแกรม 
Netscape mail, โปรแกรม Eudora หรือ โปรแกรม IE Mail 
เปนตน Off-line mail เหมาะกับผูที่มีเครื่องเปนของตนเอง 
โปรแกรมที่เรียกใชผานเว็บ 
เปนแบบที่นิยมกันในปจจุบัน โดยจะทําการติดตั้งโปรแกรม

เว็บเซิรฟเวอร พรอมกับโปรแกรมเว็บเฉพาะ ใหทําหนาที่ไปติด
ตอกับเมลเซิรฟเวอร ผูใชสามารถเขาใชงานผานโปรแกรมเบรา
เซอรจากที่ใด ๆ ก็ได  และมีขอดีคือไมตองเซ็ตคาเริ่มตนตาง ๆ 
ใหยุงยากเหมือน Off-line mail  และจะใชจากเครื่องที่ไหนก็ได 
บทสรุป 

SWU Web Mail เปนความพยายามอีกครั้งหนึ่งในการ
ปรับระบบอีเมลของ มศว ใหสามารถรองรับการเรียกใชงาน
โดยผานเว็บ เพื่ออํานวยความสะดวกและมีความปลอดภัย
ใหมากยิ่งขึ้น อีเมลระบบใหมนี้ยังสามารถใหผูใชเรียกใชงาน
ในลักษณะ Off-line mail โดยผานโปรแกรม เชน Outlook 
express, Eudora, IE mail หรือ Netscape mail ได แต
สําหรับการเรียกใช โดยผานโปรแกรม Pine ซึ่งเปนลักษณะ 
Host-base mail จะตองปดบริการไป  
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ฐานขอมูล ฐานขอมูล 
ฐานขอมูล (Database) คือ กลุมของขอมูลที่ถูกรวบรวมไว

ดวยกัน อยางมีระบบ แบบแผน เปนหมวดหมู และมีความ
สัมพันธกับขอมูลชุดอื่นๆ ที่เกี่ยวของ เชนขอมูลของลูกคา จะ
ตองเกี่ยวของกับขอมูลสินคา และขอมูลพนักงานขาย เปนตน 
โมเดลฐานขอมูลที่เปนที่นิยมใชในงานประยุกต คือ โมเดล
ฐานขอมูลเชิงสัมพันธ (Relational Database Model) ซึ่งจะมี
โปรแกรมจัดการฐานขอมูล (DataBase Management 
System: DBMS) เปนซอฟทแวรในการจัดการ  

ฐานขอมูล (Database) คือ กลุมของขอมูลที่ถูกรวบรวมไว
ดวยกัน อยางมีระบบ แบบแผน เปนหมวดหมู และมีความ
สัมพันธกับขอมูลชุดอื่นๆ ที่เกี่ยวของ เชนขอมูลของลูกคา จะ
ตองเกี่ยวของกับขอมูลสินคา และขอมูลพนักงานขาย เปนตน 
โมเดลฐานขอมูลที่เปนที่นิยมใชในงานประยุกต คือ โมเดล
ฐานขอมูลเชิงสัมพันธ (Relational Database Model) ซึ่งจะมี
โปรแกรมจัดการฐานขอมูล (DataBase Management 
System: DBMS) เปนซอฟทแวรในการจัดการ  

 การออกแบบฐานขอมูล  การออกแบบฐานขอมูล 
ในการออกแบบฐานขอมูล มีขั้นตอนดังนี้  ในการออกแบบฐานขอมูล มีขั้นตอนดังนี้  
1. วิเคราะหดูวาจําเปนตองเก็บของมูลอะไรบางลงใน

ระบบ ซึ่งกอนที่จะไดมานั้นตองมีการสํารวจขอมูลจาก
ผูใชงานเสียกอน เชนวาอยากไดรายงานอะไร, 
แบบฟอรมมีหนาตาอยางไร แสดงขอมูลอะไรบาง  
จากนั้นวิเคราะหถึงความเปนไปไดในอนาคต 

1. วิเคราะหดูวาจําเปนตองเก็บของมูลอะไรบางลงใน
ระบบ ซึ่งกอนที่จะไดมานั้นตองมีการสํารวจขอมูลจาก
ผูใชงานเสียกอน เชนวาอยากไดรายงานอะไร, 
แบบฟอรมมีหนาตาอยางไร แสดงขอมูลอะไรบาง  
จากนั้นวิเคราะหถึงความเปนไปไดในอนาคต 

2. จัดขอมูลออกเปนกลุม โดยสามารถจัดความสัมพันธ
ของขอมูลแตละกลุมได เชนขอมูลพนักงาน, ขอมูล 
สินคา เปนตน 

2. จัดขอมูลออกเปนกลุม โดยสามารถจัดความสัมพันธ
ของขอมูลแตละกลุมได เชนขอมูลพนักงาน, ขอมูล 
สินคา เปนตน 

3. นําขอมูลแตละกลุมแยกออกเปนองคประกอบใหเล็กที่
สุด เชนขอมูลพนักงาน ประกอบดวย รหัสพนักงาน, 
ชื่อ, นามสกุล, วัน-เดือน-ป เกิด, เพศ เปนตน และ
พิจารณาวาขอมูลเหลานั้นมีชนิด (data type) เปน
อยางไร  เชน มีชนิดเปนขอความ, วันที่, หรือตัวเลข 

3. นําขอมูลแตละกลุมแยกออกเปนองคประกอบใหเล็กที่
สุด เชนขอมูลพนักงาน ประกอบดวย รหัสพนักงาน, 
ชื่อ, นามสกุล, วัน-เดือน-ป เกิด, เพศ เปนตน และ
พิจารณาวาขอมูลเหลานั้นมีชนิด (data type) เปน
อยางไร  เชน มีชนิดเปนขอความ, วันที่, หรือตัวเลข 

4. จากขอ 2 จะไดตาราง (table) ที่เก็บขอมูลกลุมนั้นๆ 
และจากขอ 3 จะไดชื่อฟลด (field) ในตาราง  

4. จากขอ 2 จะไดตาราง (table) ที่เก็บขอมูลกลุมนั้นๆ 
และจากขอ 3 จะไดชื่อฟลด (field) ในตาราง  

5. หาฟลดที่สามารถระบุรายการที่ไมซ้ําไดเปนคียหลัก 
(Primary key) ของแตละตาราง เชน รหัสพนักงาน, 
รหัสสินคา เปนตน 

5. หาฟลดที่สามารถระบุรายการที่ไมซ้ําไดเปนคียหลัก 
(Primary key) ของแตละตาราง เชน รหัสพนักงาน, 
รหัสสินคา เปนตน 

6. กําหนดคาที่เปนไปไดของแตละฟลด (Constraint)  6. กําหนดคาที่เปนไปไดของแตละฟลด (Constraint)  
7. สรางความสัมพันธระหวางตารางดวยการกําหนดคีย

นอก (Foreign key)  เชน ตารางพนักงาน กับตาราง
ใบส่ังซื้อนั้น จะมีรหัสพนักงานทั้ง 2 ตาราง ซึ่งรหัส
พนักงานในตารางใบสั่งซื้อนี้ไมไดเปนคียหลัก แตจะ
เปนคียหลักของตารางพนักงาน ซึ่งเราจะเรียกรหัส
พนักงานในตารางใบสั่งซื้อนี้เปนคียนอก และฟลด

รหัสพนักงานนี้จะเปนตัวเชื่อมตารางพนักงานกับ 
ตารางใบสั่งซื้อ    

7. สรางความสัมพันธระหวางตารางดวยการกําหนดคีย
นอก (Foreign key)  เชน ตารางพนักงาน กับตาราง
ใบส่ังซื้อนั้น จะมีรหัสพนักงานทั้ง 2 ตาราง ซึ่งรหัส
พนักงานในตารางใบสั่งซื้อนี้ไมไดเปนคียหลัก แตจะ
เปนคียหลักของตารางพนักงาน ซึ่งเราจะเรียกรหัส
พนักงานในตารางใบสั่งซื้อนี้เปนคียนอก และฟลด

รหัสพนักงานนี้จะเปนตัวเชื่อมตารางพนักงานกับ 
ตารางใบสั่งซื้อ    

A
• สรางตารางดวย Design View  โดยเลือกรายการ 

Create table in Design view 

s

• สรางความสัมพันธระหวางตาราง s

9 เลือกตารางทั้งหมดที่สรางแลว นํามาแสดงใน
วินโดวส Relationships 

0

9 ทําเครื่องหมายหนา Enforce Referential 
Integrity ซึ่งจะสงผลใหตองมีขอมูลนั้นใน 
ตารางพนักงานกอนจะสรางใบสั่งซื้อสินคา 

 สรางฐานขอมูลดวย Microsoft Access 2000 
จากสิ่งที่กลาวมานี้ ลองมาสรางฐานขอมูลอยางงาย  ดังนี้ 
• เรียกโปรแกรม Access  
• เลือกรายการ Create a 

New Database Using 
Blank Database หรือ
เลือกเมนู File -> New 
Database แลวเลือก 
Blank Database  

• ตั้งชื่อไฟลฐานขอมูล  

9 ชื่อฟลดตางๆ และชนิดของขอมูลที่ผาน
การวิเคราะหออกแบบฐานขอมูล ดังรูป 
พิมพ

9 เลือกฟลดที่เปน Primary key คลิกที่ไอคอน 
Primary Key ซึ่งเปนไอคอนลูกกุญแจ 

9 าของขอมูลที่เปนไปได (Constraint) 
ในชอง Validation Rule เชน เพศ สามารถเก็บ
คาเฉพาะ หญิง (F) หรือ ชาย (M)  

กําหนดค

9 เลือกเมนู Tools -> Relationships 

9 สรางความสัมพันธดวยการลากชื่อฟลดที่เปน 
Primary key ไปยัง Foreign key    ของอีก 
ตารางหนึ่ง ดังรูปดานซาย 

หากไดคํานึงถึงเรื่องการกําหนด Primary key, Constraint, 
Foreign key แลว ฐานขอมูลก็จะมีความนาเชื่อถือ� 

 



4 จดหมายขาวสํานักคอมพิวเตอร 

 การบํารุงรักษาเครื่องไมโครคอมพิวเตอร  
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  ดิเรก    อึ้งตระกูล 

การบํารุงรักษาเครื่องไมโครคอมพิวเตอรบนเครือขายบัวศรี 
รือที่ เรา เรียกกันว า  การทํ า  PM เป นคํ าย อของคํ าว า 
reventive Maintainance มีความหมายวา การบํารุงรักษา
พื่อการปองกัน  การทํา PM นั้นถือเปนโครงการหนึ่งตาม
โยบ าย ข อ งสํ านั ก ค อม พิ ว เต อ ร ที่ ริ เริ่ ม โด ย  ผู ช ว ย
าสตราจารยศิรินุช เทียนรุงโรจน อดีตผูอํานวยการสํานัก
อมพิวเตอร ในป พ.ศ. 2541 และมีอาจารยอุราพร ศุขะทัต 
อง ผู อํ าน วยการฝ ายปฏิ บั ติ ก า รและบ ริก า ร  สํ านั ก
อมพิวเตอร เปนผูดําเนินการ 
สํานักคอมพิวเตอรดําเนินการปฏิบัติงาน PM ในเดือน
ีนาคม ของทุกป  ระยะเวลาที่ใชในการปฏิบัติงาน ประมาณ 
5 วัน ซึ่งขอบเขตในการทํางานมีดังนี้ 
1. การตรวจสอบฮารดแวร 
2. การตรวจสอบซอฟตแวร 
3. การตรวจสอบอุปกรณตอพวง ตาง ๆ 
4. การตรวจสอบระบบเน็ทเวิรคบนเครือขาย 
5. การตรวจเช็คไวรัสคอมพิวเตอร 
6. การแนะนําการใชงานเครื่องไมโครคอมพิวเตอร 
7. การติดสติ๊กเกอรผานการตรวจสอบ 
8. การเก็บขอมูล ตาง ๆ ไมวาจะเปนจํานวนเครื่อง 

ไมโครคอมพิวเตอร วัตถุประสงคของการใชงาน 
อายุการใชงาน เพ่ือรวบรวมทําเปนสถิติ 

สาเหตุที่พวกเราเลือกเดือนมีนาคมนั้น มาจากชวงเวลานั้น
ปนชวงปดภาคการศึกษา ภาคฤดูรอน ทําใหเรามีเวลาในการ
ฏิบั ติ งานมากขึ้ น  เพ ราะนิ สิตที่ เข ามาติดตอกับทาง
หาวิทยาลัย และทางสํานักคอมพิวเตอรลดนอยลง การ
ํางานของพวกเราจะสะดวกยิ่งขึ้น 
ตั้งแตนั้นมาเราก็เลยถือวา ในชวงปดภาคการศึกษา ภาค
ดูรอน เปนชวงเวลาที่พวกเราตองทําการ PM ใหกับหนวย
านทุกหนวยงานในมหาวิทยาลัยทั้งที่ประสานมิตรและ 
งครักษ  
ในการนี้ทางสํานักคอมพิวเตอรเราจึงไดจัดสงเจาหนาที่
องสํ านั กคอมพิ วเตอร  พรอมนิ สิตวิชาเอกวิทยาการ
อมพิวเตอรของคณะวิทยาศาสตร  ที่ตองการจะมีความรู มี
ระสบการณในการทํางานกับคอมพิวเตอร หรือตองการที่จะ
ีประสบการณในการทํางานเปนทีม เปนผูชวยอีกแรง 
 

คราวนี้ เรามาลองดูสถิติที่ เราเก็บมาได  ในการทํา PM  
ป ระ จํ า ป  2545 ระ ห ว า ง วั น ที่  25 มี น าค ม  ถึ ง  วั น ที่  3 
พฤษภาคม พ.ศ. 2545 

ตารางที่ 1 จํานวนเครื่องจําแนกตามกลุมหนวยงาน 
กลุมหนวยงาน จํานวนเครื่อง 

คณะ/บัณฑิตวิทยาลัย 1,707 
สํานักอธิการบดี 185 
สํานัก 454 
สถาบัน 30 
ศูนย/สภา 29 
รวม 2,405 

 
ตารางที่ 2 จํานวนเครื่องจําแนกตามอายุการใชงาน 

อายุการใชงาน จํานวนเครื่อง 
1 ป 827 
2 ป 407 
3 ป 436 
4 ป 334 
5 ป 285 
เกิน 5 ป 116 
รวม 2,405 

 
ตารางที่ 3 จํานวนเครื่องจําแนกตามรุนเครื่อง 

ไมโครคอมพิวเตอร 
รุนเครื่องไมโคร

คอมพิวเตอร (CPU) 
จํานวนเครื่อง 

486 161 
Pentium 594 
Pentium II 620 
Pentium III-IV 1,030 
รวม 2,405 

 
 

 บริการ คือ งานสําคัญของเรา 
 



ปที่ 6 ฉบับที่ 2 (พฤษภาคม – มิถุนายน 2545) 5 

                Srinakharinwirot Online Teaching & Learning (SOT)                 Srinakharinwirot Online Teaching & Learning (SOT) 
 มศว ปค.003 ออนไลน  มศว ปค.003 ออนไลน 

 อาจารย ดร.  สุณี รักษาเกียรติศักดิ์  อาจารย ดร.  สุณี รักษาเกียรติศักดิ์ 
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มหาวิทยาลัยไดมีนโยบายในการประกันคุณภาพการเรียน
การสอนขอหนึ่ง ที่ใหมีการสอบถามความคิดเห็นเกี่ยวกับการ
เรียนการสอนจากนิสิตในทุกวิชา  ไดดําเนินการตั้งแตภาค
การศึกษาที่ 1/2543  โดยใชแบบฟอรมกลางที่เรียกวาแบบ 
มศว ปค.003  ซึ่งอาจารยและนิสิตสวนใหญคุนเคยดี 

มหาวิทยาลัยไดมีนโยบายในการประกันคุณภาพการเรียน
การสอนขอหนึ่ง ที่ใหมีการสอบถามความคิดเห็นเกี่ยวกับการ
เรียนการสอนจากนิสิตในทุกวิชา  ไดดําเนินการตั้งแตภาค
การศึกษาที่ 1/2543  โดยใชแบบฟอรมกลางที่เรียกวาแบบ 
มศว ปค.003  ซึ่งอาจารยและนิสิตสวนใหญคุนเคยดี 
เมื่อใหมีการดําเนินการดังกลาว  ผลที่เกิดขึ้นคือหนวยงาน

มีปญหาในการประมวลผล  ซึ่งกวาขอมูลที่ไดสอบถามไป
แลว จะถูกประมวลผลก็ใชเวลานานมาก  และบางหนวยงาน
ก็ไมสามารถดําเนินการได  ตอมาฝายประกันคุณภาพการ
ศึกษาของมหาวิทยาลัยไดขอความอนุเคราะหมายังขาพเจา
ผานสํานักคอมพิวเตอรใหชวยเขียนโปรแกรมในการประมวล
ผลจากแบบ มศว ปค.003 เมื่อวันที่ 30 พฤษภาคม 2544   

เมื่อใหมีการดําเนินการดังกลาว  ผลที่เกิดขึ้นคือหนวยงาน
มีปญหาในการประมวลผล  ซึ่งกวาขอมูลที่ไดสอบถามไป
แลว จะถูกประมวลผลก็ใชเวลานานมาก  และบางหนวยงาน
ก็ไมสามารถดําเนินการได  ตอมาฝายประกันคุณภาพการ
ศึกษาของมหาวิทยาลัยไดขอความอนุเคราะหมายังขาพเจา
ผานสํานักคอมพิวเตอรใหชวยเขียนโปรแกรมในการประมวล
ผลจากแบบ มศว ปค.003 เมื่อวันที่ 30 พฤษภาคม 2544   
เจาหนาที่ของสํานักคอมพิวเตอรไดดําเนินการภายใตการ

กํากับดูแลของขาพเจา เขียนโปรแกรมเสร็จและนําเสนอในที่
ประชุมคณะกรรมการประกันคุณภาพฯ ในวันที่ 13 กันยายน 
2544  และจัดฝกอบรมใหบุคลากรของหนวยงานในวันที่ 29 
ตุลาคม 2544  เพื่อใหสามารถประมวลผลขอมูลแบบ มศว 
ปค.003 ไดเอง  

เจาหนาที่ของสํานักคอมพิวเตอรไดดําเนินการภายใตการ
กํากับดูแลของขาพเจา เขียนโปรแกรมเสร็จและนําเสนอในที่
ประชุมคณะกรรมการประกันคุณภาพฯ ในวันที่ 13 กันยายน 
2544  และจัดฝกอบรมใหบุคลากรของหนวยงานในวันที่ 29 
ตุลาคม 2544  เพื่อใหสามารถประมวลผลขอมูลแบบ มศว 
ปค.003 ไดเอง  
ตอมาขาพเจาไดนํารองโปรแกรมการสอบถามความคิด

เห็นเกี่ยวกับการเรียนการสอน มศว ปค.003 แบบออนไลน  
โดยให เป น โครงงานของนิ สิตป  4 วิชา เอกวิทยาการ
คอมพิ ว เตอร  โดยการสนับสนุนจากเจ าหน าที่ สํ านั ก
คอมพิวเตอร   

ตอมาขาพเจาไดนํารองโปรแกรมการสอบถามความคิด
เห็นเกี่ยวกับการเรียนการสอน มศว ปค.003 แบบออนไลน  
โดยให เป น โครงงานของนิ สิตป  4 วิชา เอกวิทยาการ
คอมพิ ว เตอร  โดยการสนับสนุนจากเจ าหน าที่ สํ านั ก
คอมพิวเตอร   
ไดมีการทดลองใชการสอบถามความคิดเห็นในการเรียน

การสอน มศว ปค.003 ออนไลน ในวิชา คพ 101 ซึ่งนิสิตตอง
เขาหองปฏิบัติการคอมพิวเตอรอยูแลว  และในวิชาอื่น ๆ อีก
ในภาคเรียนที่ 2/2544 ระหวางวันที่ 12 กุมภาพันธ – 1 
มีนาคม 2545  และไดรายงานผลการดําเนินงานใหที่ประชุม
คณะกรรมการประกันคุณภาพการศึกษาทราบ เมื่อวันที่ 4 
มีนาคม 2545  

ไดมีการทดลองใชการสอบถามความคิดเห็นในการเรียน
การสอน มศว ปค.003 ออนไลน ในวิชา คพ 101 ซึ่งนิสิตตอง
เขาหองปฏิบัติการคอมพิวเตอรอยูแลว  และในวิชาอื่น ๆ อีก
ในภาคเรียนที่ 2/2544 ระหวางวันที่ 12 กุมภาพันธ – 1 
มีนาคม 2545  และไดรายงานผลการดําเนินงานใหที่ประชุม
คณะกรรมการประกันคุณภาพการศึกษาทราบ เมื่อวันที่ 4 
มีนาคม 2545  
โปรแกรมนี้ยังไดใชกับการสอบถามความคิดเห็นเกี่ยวกับ

การเรียนการสอนในการอบรมครูระดับมัธยมศึกษา วิชา
คอมพิวเตอร ทั้งหลักสูตร 1 และหลักสูตร 2 ตามแบบสอบ
ถามของสมาคมวิทยาศาสตรแหงประเทศไทย ระหวางวันที่ 
29 เมษายน – 9 พฤษภาคม 2545 ดวย 

โปรแกรมนี้ยังไดใชกับการสอบถามความคิดเห็นเกี่ยวกับ
การเรียนการสอนในการอบรมครูระดับมัธยมศึกษา วิชา
คอมพิวเตอร ทั้งหลักสูตร 1 และหลักสูตร 2 ตามแบบสอบ
ถามของสมาคมวิทยาศาสตรแหงประเทศไทย ระหวางวันที่ 
29 เมษายน – 9 พฤษภาคม 2545 ดวย 

 โปรแกรม มศว ปค.003 ออนไลน  โปรแกรม มศว ปค.003 ออนไลน 
นิสิตที่จะทําแบบสอบถาม หรืออาจารยที่ประสงคจะดูผล
งแบบสอบถามสามารถเขามาเว็บไซทของโครงการ SOT 
ที่ http://sot.swu.ac.th/  แลวคลิกที่ไอคอน “การสอบถาม
ามคิดเห็นเกี่ยวกับการเรียนการสอนฯ”  จะปรากฏดังรูป 

นิสิตที่จะทําแบบสอบถาม หรืออาจารยที่ประสงคจะดูผล
ของแบบสอบถามสามารถเขามาเว็บไซทของโครงการ SOT 
ไดที่ http://sot.swu.ac.th/  แลวคลิกที่ไอคอน “การสอบถาม
ความคิดเห็นเกี่ยวกับการเรียนการสอนฯ”  จะปรากฏดังรูป 

 
นิสิตหรืออาจารยที่ตองการมาใชบริการก็จะเลือกวิชาที่

ตองการ แลวระบบจะให login  โดยใส user name และ 
password ที่เปนตัวเดียวกับระบบอีเมลบน psm   
ระบบแบบออนไลนนี้มีขอดี คือการประมวลผลจะเปนไป

ในทันทีทันใดและอาจารยผูสอนก็สามารถจะดูผลไดทันที ดัง
รูป 

 
โปรแกรมนี้ไดดําเนินการตอโดยไดนําผลการสอบถาม

ความคิดเห็นของวิชาตาง ๆ ที่ดําเนินการดวยวิธีปกติ คือฝน
ลงแบบฟอรม และหากหนวยงานนําแบบฟอรมไป scan ที่
ฝายประกันคุณภาพฯ อาจารยก็สามารถมาดูผลไดที่  

http://sot.swu.ac.th/eval  
 



6 จดหมายขาวสํานักคอมพิวเตอร 

คอมพิวเตอรและเครือขายกับงานสํานักงาน  

การสรางจดหมายเวียน (Mail Merge) 
 สมบุญ อุดมพรยิ่ง  
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  บทนํา 
บางทานอาจจะตองมีหนาที่ตองเตรียมหนังสือเชิญประชุมถึง
จํานวนมากอยูบอย  ๆ  ทานอาจจะบอกวาไมมีปญหา ก็ใช
พหนังสือเชิญประชุม ใน Microsoft Word  ตนฉบับ และ 
ลอกตัวหนังสือเชิญเทากับจํานวนผูที่เราจะเชิญประชุม และ
พชื่อผูที่ตองการเชิญประชุม ในแตละฉบับ  ก็เรียบรอยแลว  
กมีการแกไข เชน เปล่ียนวันนัดหมายการประชุม เมื่อทาน
ียมหนังสือเชิญประชุมถึงทุกคนเสร็จแลว ทานจะตองทําการ
ไขทุกฉบับ ซึ่งบางครั้งอาจจะแกไขไมครบทุกฉบับ เมื่อ 
หนังสือเชิญประชุมไปแลว  ผลกระทบที่ตามมาคือผูเขารวม
ะชุมมาประชุมคนละวันกัน  
ที่แยไปกวานั้นคือการใชลายมือเขียนชื่อผูที่ตองการเชิญ
ะชุมซึ่งดูไมสวยงามและไมเปนมืออาชีพ 
รทําจดหมายเวียนดวย Microsoft Word 
โปรแกรม Microsoft Word มีเครื่องมือที่จะชวยใหทาน
ียมเอกสารที่มีลักษณะเหมือนกัน  ทําใหชวยประหยัดเวลา
การทํางานและทรัพยากรอันมีคาของทานอยางคุมคาที่สุด   
ื่องมือดังกลาวคือ Mail Merge  หรือการสรางจดหมาย
น  ในการทําจดหมายเวียนตองการเอกสาร 2 สวนคือ 
. เอกสารหลัก (main  document)  เปนแฟมที่เก็บเนื้อ
ความหลัก เชน  จดหมายเชิญประชุม  สัญญาโครงการ
วิจัย เปนตน 

. แหลงขอมูล (data  source)   เปนแฟมขอมูลที่เก็บขอ
มูลที่แปรเปลี่ยนไปของเอกสารแตละฉบับ เชน ผูที่
ตองการสงจดหมายเชิญสําหรับจดหมายเชิญประชุม
หรือ ชื่อผูวิจัย, ที่อยูผูวิจัย, ชื่อโครงการวิจัย, เงินอุดหนุน
วิจัย เปนตน สําหรับสัญญาโครงการวิจัย  แหลงขอมูล
จะอยูในรูปของตารางขอมูล   ซึ่งอาจสรางมาจาก MS 
word, Excel, หรือ ฐานขอมูล อื่นๆ 

รผนวกเอกสารหลักกับแหลงขอมูล 
เมื่อเตรียมเอกสารหลักและแหลงขอมูลเรียบรอยแลว   
เปดไฟลของเอกสารหลักไว แลวเลือกเมนู  
ols -> Mail Merge ซึ่งมี 4 ขั้นตอน 
. Main document เลือก Create -> Form Letters 
แลวเลือก Active window 

. Data Source เลือก GetData -> Open Data Source  
แลวเลือกไฟลที่เก็บแหลงขอมูล 

3. Merge the Data with Document  เลือก Merge หาก 
Mail Merge ไมพบ Merge field ก็จะใหเราเลือก Edit 
Document  แลวเลือก Insert field ตามตําแหนงที่
ตองการในเอกสารหลัก  เมื่อเลือกฟลดที่ตองการแลวจะ
ปรากฏเครื่องหมาย <<  >>  กั้นแตละฟลดผนวก 

4. กลับไปเลือก Tools -> Mail Merge อีกครั้งหนึ่ง แลว
เลือก 3 Merge  ก็จะไดเอกสาร Form Letter จํานวนตาม
ที่ตองการ  โดยสามารถ ผนวกเอกสารหลักกับแหลง 
ขอมูลทั้งหมด หรือ เลือกเฉพาะขอมูลได จาก Records 
to be merged   

 
ประโยชนของการใช Mail Merge  
เมื่อเราใช Mail Merge  ในการทําจดหมายเวียน  ในการ

เก็บสําเนาของจดหมายเราก็เพียงแตเก็บเอกสารหลัก และ 
ตารางแหลงขอมูลไวอางอิงก็เพียงพอ  ไมตองสําเนาจดหมาย
ทุกฉบับเก็บไว  นอกจากนั้นแลวไฟลแหลงขอมูลเราอาจะใช
เก็บขอมูลฟลดอื่น ๆ  ที่ไมไดใชในการ merge แตใชในงานอื่น  
เชน  เก็บหมายเลขโทรศัพทของผูที่เราเชิญประชุม เพื่อการติด
ตอ  และยังสามารถดัดแปลงไฟลแหลงขอมูลมาเปนใบเซ็นชื่อ
ของผูเขารวมประชุมได   
สํานักคอมพิวเตอรจะไดเตรียมแหลงขอมูลที่ใชบอย ๆ ของ

มหาวิทยาลัย  เชน  ตําแหนงตาง ๆ ของผูบริหารมหาวิทยาลัย
ใหสําหรับผูใช    โปรดติดตามตอไป 
 สรุป 
การสรางจดหมายเวียนยังสามารถนํามาใชประยุกตกับ

งานดานตางๆ ในสํานักงานไดอีกมากมาย  เชน  การพิมพ
สัญญาโครงการวิจัยของฝายวิจัย  เปนตน   
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มาประกาศ Course Syllabus ผานเน็ตกันเถอะ 
� ดร.ขนิษฐา รุจิโรจน �

ในปการศึกษา 2545 นี้ สํานักคอมพิวเตอรไดรับมอบหมาย
จากมหาวิทยาลัยใหจัดสรางระบบและกลไกเพื่อสนับสนุน
คณะ /สถาบ ัน ใน เรื ่อ งการจ ัดทําและเผยแพร Course 
Syllabus ของทุกรายวิชาในทุกระดับช้ันที่เปดสอน  ผานเว็บ
ไซทของมหาวิทยาลัย  โดยให เปนสวนหนึ่ งของโครงการ 
Srinakharinwirot Online Teaching & Learning หรือ SOT 
บทความนี้ขอแนะนําเว็บไซท Course Web Page และ

เครื่องมือที่มีชื่อเรียกวา Course Publisher ซึ่งจัดเปนระบบ
งานบริการผานเว็บที่ไดพัฒนาขึ้นเพื่ออํานวยความสะดวกแก
คณาจารยในการจัดทําและเผยแพร Course Syllabus ผานเว็บ 
และไดเปดใหบริการตั้งแตวันที่ 30 พฤษภาคม 2545 
Course Web Page: แหลงรวบรวมเว็บเพจรายวิชา 

จาก Quick Links ในโฮมเพจของมหาวิทยาลัย จะพบ 
Course Web Page เปน link ที่จะพาไปยังเว็บไซทซึ่งเปน
แหลงรวบรวมเว็บเพจเกี่ยวกับรายวิชาที่เปดสอนในแตละภาค
การศึกษา เมื่อเขาถึง Course Web Page แลวหนาแรกจะ
เปนสวนที่เรียกวา Course Directory ซึ่งจะพบตัวชวยในการ
คนหาเพื่อพาไปยังเว็บเพจที่ตองการอยู 2 วิธี ดังนี้ 
� Course Listing 

เปนวิธีเขาถึงเว็บเพจของวิชาดวยการเลือกรายวิชาที่ภาค
วิชาเปดสอนในภาคการศึกษานั้น  ถาวิชาใดไดจัดทําเว็บ
เพจผานระบบ Course Publisher จะพบ link ที่สวนของ
ตอนที่ (section) ซึ่งจะพาไปยังเว็บเพจของรายวิชานั้น 
� Search Course Web Page 

เปนวิธีเขาถึงเว็บเพจดวยการระบุรหัสวิชา (Course ID) 
และตอนที่ (Section No.) ลงใน Search box 

 
Course Directory: หนาแรกของ Course Web Page 

เมื่อเขาถึง Course Web Page ของรายวิชาใดจะพบ Course 

Overview ถาคลิก Syllabus จะพบ Syllabus ของวิชานั้น 

 
ตัวอยางของ Course Syllabus ที่สรางจาก Master Form 

Course Publisher: เครื่องมือจัดทําเว็บเพจรายวิชา 

คณาจารยผูสนใจจัดทํา Syllabus ดวย Course Publisher 
จะสามารถเขาใชบริการนี้ได โดยคลิกที่ Course Publisher ซึ่ง
อยูในเมนูทางดานซายมือของหนา Course Directory จาก
นั้นจะพบ Course Publisher Login 

 
หนา Login กอนที่จะเขาสู Course Publisher 

กอนเขาสู Course Publisher ทานจะผานการตรวจสอบสิทธิ
ในการเขาใชระบบ โดยทานตองระบุขอมูล รหัสวิชาตัวเลข 

พรอมทั้งระบุ ตอนที่ และ เลขประจําตัวผูสอน จากนั้นเลือก
วิธีการสราง Syllabus ซึ่งมีไวใหเลือก 2 แบบ คือ จาก
แบบฟอรม (Master Form) หรือ สงแฟม (Upload File) ถาระบุ
ขอมูลถูกตอง จะพบแบบฟอรมพรอมขั้นตอนการจัดทํา ซึ่งถา
ไดลองสักครั้ง จะพบวางายจริง ๆ ทานก็ทําไดดวยตนเอง 

...ภายในเวลาเพียงไมกี่นาที ทานก็จะสามารถประกาศดวย
ความภาคภูมิใจใหนิสิตของทานและคนทั่วโลกไดรับรูวา… 

“Yes! I teach this course … and here’s the outline…” 

ทานมีเว็บรายวิชาที่ทานสอนในภาคการศึกษานี้หรือยัง ? 
ถายัง... มาลองใช Course Publisher ประกาศ Course 
Syllabus ผานเน็ตกันเถอะ...     จาก.Course Publisher Team� 
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ขาวกิจกรรมและบริการ 
สํานักคอมพิวเตอร 

สาธิต การใชบริการ Internet/E-mail 
ผานเครือขายบัวศรี 

 สํานักคอมพิวเตอร  ใหบริการการใชงาน Internet และ E-
mail สําหรับคณาจารย บุคลากรและนิสิตของมหาวิทยาลัย 
และมีการสาธิตการใชบริการ Internet/E-mail ผานเครือขาย
บัวศรี ทุกวันพุธเวลา 14.00-14.40 น. ระหวางวันที่ 5 มิ.ย.-
31 ก.ค.45  ชมการสาธิตและขอรับ Buasri Account  ซึ่ง
ประกอบดวย username และ password ไดที่สํานัก
คอมพิวเตอร   
สาธิตการใชโปรแกรมจัดทําเคาโครงการเรียน 

การสอน (Course Publisher) 
 สํานักคอมพิวเตอร สาธิตการใชโปรแกรม Course 

Publisher ระหวางวันที่  30 - 31 พฤษภาคม 2545 ,11 –14  
มิถุนายน  2545 ณ หองบรรยาย  406  และการทํา 
Workshop ระหวางวันที่  3 – 7,11 - 14  มิถุนายน 2545   
ณ   หองปฏิบัติการคอมพิวเตอร 302 ใชโปรแกรมไดที่ 
http://www.swu.ac.th/ หัวขอ  Course Web Page  
โครงการเสวนาไอที (IT Talk) 

สํานักคอมพิวเตอร ไดจัดใหมีการเสวนาไอที  (IT Talk) 
เพื่อนําเสนอ/บรรยาย ความรูในการใชเทคโนโลยีสารสนเทศ
ในดานตาง  ๆ   จากบุคลากรภายในมหาวิทยาลัยและ 
ภายนอกมหาวิทยาลัย  ทุกวันอังคาร เวลา 12.20 น ณ  หอง 
16-406 ชั้น 4  อาคารสํานักคอมพิวเตอร  

กําหนดการเดือนกรกฎาคม-สิงหาคม มีดังนี้ 
ครั้งที่ 15 วันที่ 2 ก.ค. 45 เรื่อง “Web Services Part II” 
ครั้งที่ 16 วันที่ 9 ก.ค. 45 เรื่อง “การ Over Clock PC” 
ครั้งที่ 17 วันที่ 16 ก.ค. 45 เรื่อง “Viewlet: โปรแกรมที่ชวย

ในการสาธิตการใชซอฟทแวร” 
ครั้งที่ 18 วันที่ 23 ก.ค.45 เรื่อง “การ Download file  

อยางรวดเร็ว” 
ครั้งที่ 19 วันที่ 30 ก.ค. 45 เรื่อง “เทคนิคการซื้อ Note 

Book” 
ครั้งที่ 20 วันที่ 6 ส.ค. 45 เรื่อง “ลินุกซทะเล: ระบบปฏิบัติ

การลินุกซบนเครื่องเดสกทอป” 
ครั้งที่ 21 วันที่ 13 ส.ค. 45 เรื่อง “การใชงานโปรแกรม  

share  Point” 

ครั้งที่ 22 วันที่ 20 ส.ค. 45 เรื่อง “การสนทนาผานเครือขาย
ดวยโปรแกรม  MSN  
Messager” 

ครั้งที่ 23 วันที่ 27 ส.ค. 45 เรื่อง “การสราง VCD  สวนตัว” 

  

ดูรายละเอียด สํารองที่นั่ง และ download เอกสารของ
การเสวนาไดที่ http://sot.swu.ac.th/swucc/ITtalk/  
โครงการความรวมมือ 

- สํานักคอมพิวเตอรรวมกับทบวงมหาวิทยาลัย จัดอบรม
เชิงปฏิบัติการ “การออกแบบและติดตั้งระบบรักษาความ
ปลอดภัยในเครือขายสมาชิก UniNet“  ระหวางวันที่  13-15  
พฤษภาคม 2545 เวลา 9.00 – 16.15 น. ณ   หองปฏิบัติการ
คอมพิวเตอร  313  ชั้น 3  

- คณะสังคมศาสตร มศว สมาคมภูมิศาสตรแหงประเทศ
ไทย และ IGN  France International ดําเนินการความรวม
มื อ ใน โค รงก า ร  ULIS  ติ ด ตั้ ง   Web server ชื่ อ  ”www. 
huahin.in.th“ เพื่อเสนอขอมูลสารสนเทศภูมิศาสตร เปนการ
นํารองในเขตพื้นที่ของหัวหินโดยทําการทดลองติดตั้ง Web 
server ที่สํานักคอมพิวเตอร 

 
กิจกรรม 5 ส สํานักคอมพิวเตอร 

สํานักคอมพิ วเตอร   จัดให มีกิจกรรม  5 ส  และ  Big 
cleaning day เมื่อวันที่ 24 พฤษภาคม 2545  เพื่อเสริมสราง
สุขนิสัยที่ดีในการปฏิบัติงาน และสภาพแวดลอมที่ดี  เปน 
กิจกรรมที่ดําเนินการอยางตอเนื่อง  ปละ 2 ครั้ง กอนเปด
ภาคการศึกษาปกติ  
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